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SUPPORT SERVICES 

Relate Software is committed to strong customer service and satisfaction. At all times you will be able to make contact with our 
company and our technical service teams. Relate Software will provide the highest level of customer service and will provide 
telephone support as well as online remote access support and where applicable we will call out onsite to help resolve any support 
issue. 
 
You can make contact with our support department in the following ways: 
 
Telephone: 
 
Ireland: +353 (0)1 4597800 
United Kingdom: +44 (0) 871 284 3446 
 
Fax: +353 (0)1 4597779 
 
Email: support@relate-software.com 
 
Opening Times for Support 09:00-13:00, 14:00-17.30 
We also provide out of hours support via mobile phone. If you find that you need out of hours support simply call the support 
department and they will provide you with a mobile number where support will be available at an agreed time.
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COPYRIGHT 
This document and software described in it are copyrighted with all rights reserved. Under copyright laws, neither the documentation 
nor the software may be copied, photocopied, reproduced, translated or reduced to any electronic medium or machine readable form, 
in whole or in part, without prior written consent of Relate Software (’Relate’). Failure to comply with this condition may result in 
prosecution.  
 
This computer program is the property of Relate. The program is protected under copyright law and is licensed strictly in accordance 
with the conditions specified in the Software Licence. Sale, lease, hire, rental or reassignment to, or by, a third party without the prior 
and written permission of Relate is expressly prohibited.  
 
Relate does not warrant that the software package will function properly in every hardware / software environment. For example, the 
software may not work in combination with modified versions of the operating system, with certain print-spooling or file facility 
programs, or with certain printers supplied by independent manufacturers.  
 
Although Relate has tested the software and reviewed the documentation, Relate makes no warranty or representation, either 
express or implied, with respect to this software or documentation, his or her quality, performance, merchantability, or fitness for a 
particular purpose. This software and documentation are licensed ‘as is’, and you, the licensee, by making use thereof, are assuming  
the entire risk as to their quality and performance.  
 
In no event will Relate be liable for direct, indirect, special, incidental, or consequential damages arising out of the use or inability to 
use the software or documentation, even if advised of the possibility of such damages.  
 
Disclaimer: Relate’s policy is one of constant development and improvement. We reserve the right to alter, modify, correct and 
upgrade our software programs and publications without notice and without incurring liability.  
 
Copyright:   2006 Relate Software  
                    Unit D6, South City Business Park, 
                    Whitestown Way, Tallaght, Dublin 24 
 
Issue Date: 12/01/2009                    All Worldwide Rights Reserved  
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INSTALLATION 

How to install the software for the first time is explained in this chapter. It covers a Standalone (single user) installation and Network 

(multi-user) installations. 

 

This chapter will outline how to install Relate Personal Tax Manager on to one computer or a network for the first time. The following 

topics will be covered in detail: 

  

• Standalone/Network System Requirements 

• Standalone/Network Installation 

• Starting Relate Personal Tax Manager  

• Product Registration 

• Support Services 
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Standalone/Network System Requirements   
 
When installing Relate Personal Tax Manager for the first time please take note of the following and recommended system 
requirements. 
 

Standalone System Requirements 
 
The minimum requirement for a computer to run the Relate Personal Tax Manager is a P4 processor or better. The computer will 
need 512MB of memory (Vista – 1GB) and at least 50Mbytes of free space on the hard disk. 
 
The computer will need to run on one of the following operating systems: 
 

• Microsoft Windows 2000 Professional 

• Microsoft Windows NT Workstation V4 
• Microsoft Windows XP 

• Microsoft Windows Vista 
 

 

The recommended requirement for a computer to run the Relate Personal Tax Manager is a processor of 200MHz or above. The 
computer will need 1GB of memory (Vista – 2GB). An SVGA monitor which should support a screen resolution of at least 800 x 600 
pixels.   
 
The computer will need to run on one of the following operating systems: 
 

• Microsoft Windows 2000 Professional 

• Microsoft Windows NT Workstation V4 

• Microsoft Windows XP 
• Microsoft Windows Vista 
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Network System Requirements 
 
The minimum requirement for a SERVER to run the Personal Tax Manager is a P4 processor or better (or compatible equivalent). 
The computer will need 1GB of memory and at least 50Mbytes of free space on the hard disk. 
 

The minimum requirement for a WORKSTATION running the Personal Tax Manager is P4 processor or better (or compatible 
equivalent). The computer will need 512 (Vista – 1GB) of memory and at least 50Mbytes of free space on the hard disk. An SVGA 
monitor which should support a screen resolution of at least 800 x 600 pixels.   
 
The computer will need to run on one of the following operating systems: 
 

• Microsoft Windows 2000 Professional 
• Microsoft Windows NT Workstation V4 

• Microsoft Windows XP 

• Microsoft Windows Vista 
 

Relate Personal Tax Manager will run on a Peer-to-Peer network but we do not recommend the use of this kind of network.  
 

The recommended requirement for a SERVER running the Personal Tax Manager is a P4 processor or better (or compatible 
equivalent). The computer will need 4GB of memory and at least 200Mbytes of free space on the hard disk 
 

The recommended requirement for a workstation running the Personal Tax Manager is a P4 processor or better (or compatible 
equivalent). The computer will need 1GB (Vista – 2GB) of memory and at least 200Mbytes of free space on the hard disk. An SVGA 
monitor which should support a screen resolution of 800 x 600 pixels.   
 
The computer will need to run on one of the following operating systems: 
 

• Microsoft Windows 2000 Professional 
• Microsoft Windows NT Workstation V4 

• Microsoft Windows XP 

• Microsoft Windows Vista 
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Standalone/Network Installation   
 
The installation wizard makes the process of installing Relate Personal Tax Manager an easy and straightforward exercise.  
 
The standalone and network installation can be run from one CD.  
 

1. Place the program CD into the CD-ROM drive. If you have auto run enabled on your CD-ROM drive, the installation 
wizard will automatically appear.  If it does, skip to step 4 

 
2. From your Windows Desktop, click on the Start Button and the start menu will appear. From the Start Menu choose 

Run. The Run window appears as follows: 

 

Figure 1 
3. When you press OK the standard Relate Personal Tax Manager installation wizard will appear  
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4. The installation wizard begins and the setup program will display the first screen. The screen will appear as follows: 

 

Figure 2 

5. Click Next.  

6. The following screen appears  
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Figure 3 
 
 

7. The installation wizard will now ask you where you want the Relate Personal Tax Manager program installed.  
8. We recommend that you use the default directory.   
9. We recommend that you install for everyone who uses the PC, but you may select a specific user if you wish. 
10. Click Next 
11. The installation is now ready to start copying the program and data files to your computer. Should you want to use a 

different folder click the back button. 
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Figure 4 
 

12. Click Next 
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Figure 5 
 
 
 

13. The installation of the program and data files occurs as shown on the above screen. 
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Figure 6 

 

14. Click Close, the installation is complete 
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GETTING STARTED 

1. Once the package is installed the following icon will appear on the desktop                  click the icon to start the program. 

 

2. When you launch the program for the first time, you will need to enter the Sever details as well as your Database Name.  
 

 
 
If you are a DRIVE CRM user you can get these details from DRIVE by clicking on Tools> Change Database. Take the 
details and enter them into the screen above.  

3. If this is a new installation and a new database the default login User ID. Is SYSADM and no password. 

4. Click on the desktop icon again and the system will load the Registration screen.  A Relate Software technician may 
have already registered the product for you and if so move onto the next section. If the system is not registered follow 
the instructions below. 
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Product Registration 
When you access the program for the first time the system will recognize that the program has not been registered. The 

 system will not run unless it is registered. 
 

1. To register your product call the Relate Software Hotline at 
the following number: 

Ireland       +353 (0)1 4597800 
 UK  +44 871 284 3446 

2. The registration screen will appear as in Figure 7: 
 
 

3. In order to register the software you must speak to a Relate 
Support staff member who will take you through the 
registration procedure. 

 
4. The support person will ask you to call out the Serial Number 

(registration key) that will be displayed automatically when 
you install the system. 

 
5. Complete the licence screen based upon the licence you 

have purchased along with the licence renewal date. 
 
6. The support person will now call out an Activation Key based on the information provided. 
 
7. Enter the Activation Key and click the Register button. The system has now been registered. 
 
8. You should retain a copy of your Serial Number and the best way to do this is by clicking the Print Screen button on 

your keyboard, which will print a copy for you. 
 
9. The system is now registered and ready for use. 
 

When the Licence Renewal Date is reached, you will need to renew your licence. This will usually be a year from the date of 
registration. One month in advance of the renewal date the system will give a warning to call the support hotline in order to 
get a new registration key. One month’s warning will be given. 

 

Figure 7 
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Login  
Double click on the                icon on your desktop. The Login screen will be displayed (see Figure 18). If you do not get the Login 
Screen, see Trouble Shooting. 

 

 
 

Enter your User ID and Password and click the Ok button to login to tax. If the User ID or password is incorrect then the following 
screen will appear 

 

 

 

Click the OK button. Re-enter the correct User ID and Password. If the problem persists, check your User Id and Password with your 
System Administrator.  
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CONCEPT BEHIND RELATE PERSONAL TAX MANAGER 

Relate Personal Tax Manager has been developed to help firms manage and maintain their client personal tax information. The 
package is linked to DRIVE, the most widely used Accountants CRM package on the market. The personal tax client information is 
shared between the two packages. All individuals and soletraders from DRIVE will appear in the personal tax package. If you do not 
do personal tax returns for some of these clients you can hide them. 
 
The system highlights through the tax return summary dashboard all clients with outstanding returns, returns not created as well as 
the status of their returns such as sent to client for signing or submitted to ROS. 
 
The system allows you to Import last years ROS f11.xml file into the tax database. This will read the tax information on your client and 
automatically load it as a client into Relate Personal Tax Manager. This saves a lot of time and it also allows you to roll over the 
client’s tax return information so that you can easily do the new tax return. 
 
The package allows for updating of clients personal tax information into a central database. Once updated the user can click the 
calculate button and the system will automatically send an xml file to the Revenue online calculation engine. Within seconds the 
system will return the Form 11 Calculation report.  
 
If you are happy with the tax return, simply click the submit button and the system will create the f11 file for submission. The package 
will automatically bring you to the upload section of ROS so that you can upload the file. Relate Personal Tax Manager will soon have 
the function to automatically upload the file directly to the ROS engine with notification number and status being returned to the 
package itself. 
 
The Datamining routine allows a firm to send information requests of impending tax returns to clients by using the mail merge 
function. It also allows you to run a series of data queries to get information from the tax database for example: produce a list of all 
tax clients who have rental income or list all clients who took advantage of film relief last year. 
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HOW TO NAVIGATE PERSONAL TAX 

Navigation bar: you can drag shortcuts to different positions on the navigation bar to suit the order of your work. The tax package 
does not have many shortcuts so the standard layout probably does not need adjusting. 
 
Use the text drop down menu to select the options you want to execute. 
 
Use the tool bar (new, open, print, delete and find plus screen-specific icons) by clicking on the option. 
 
The right click option on most browse screens will allow you to add, edit and delete records.  On the clients & tax returns screen view 
the status of a client’s tax return can be changed by right clicking. You can also perform a tax year rollover from this menu. 
 
Columns can be sorted (where relevant) by clicking column headers, you can filter (where relevant) columns as well as change 
column widths. Additional columns can also be selected using the Column Chooser option. 
 
Double click will generally bring you into a drill down facility where appropriate. 
 
Click on hyperlinks (to add new database items on the fly or to expand the information). Blue or blue underlined text indicates a 
hyperlink to a smaller database or lookup. 
 
Use the Find option: clicking a second time turns it off. 
 
Use Fast Search (on long browse screens). 
 
Pressing F1 will generally call up online Help if it is available. 
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HELP  
The help menu contains a couple of important options to help you when you contact our support department. The first one is the 
Relate Software Remote Support. This option allows a Relate support consultant to remotely logon to your pc and look directly at 
your screen so that you can better explain the issue you are having. When you click the option below, the system will automatically 
launch Internet Explorer and bring you to the login site. The support person will give you a secure code and you can follow their 
instructions. 
 

 
 
 
 
 
The second option is About, click on about to find out what version of the software you currently have installed. 
 

 
 
Version 1.0 Build 21 for example is what you tell the support person should they ask. 

Remote 
Support 



Success Built on Service   21 

MAIN PROGRAM WINDOW 

Relate Personal Tax manager opens on the client and Tax Returns screen. This acts as the main menu for the system.  

 

Figure 8 
On a new installation the list of clients will be blank. If you are a DRIVE or RAP User, the DRIVE/RAP client list will automatically 
appear. Only Individuals and sole traders will appear but you can add a tax return to each of the clients listed from DRIVE/RAP. You 
can add new clients, other than DRIVE/RAP clients to Personal Tax by clicking on the new button. 
 
The Return Summary dashboard allows you to keep track of returns for the current tax year. 
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USER ACCESS GROUP 

When you enter the system for the first time, you will have to use the default System Administrator’s access rights and password. 
Once Access Groups have been defined, they can be applied to individual staff. Using the access rights, you can restrict routines. 
You can password individual client returns by applying a password. 
 
Defining User Access Groups  
From the Tools menu, choose the User Access Groups option. The Access Groups window appears listing all of the available groups. 
Click Add. The Access Group window appears.  
 
 

    
 
 
 
 
 
To apply an access group to a staff member go to the staff section and edit the staff members details and apply. 

Enter a Name for the Group and then tick the 
options you want available to the group you are 
creating 
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ADD A CLIENT AND TAX YEAR 

New clients can be added through the normal add button from the clients and tax return browse but you can also use the Ros Import 
button which will automatically load your client information from their last years .f11 ROS xml file. This can save considerable time 
and effort as it will upload all the relevant information. Please note that this will upload the information into the year that the .f11 file 
relates and you will then need to do a rollover. See below for details. 
 

To add new a client tax year, click New   from the toolbar. New Client and Tax Year window appears as follows: 

 
Figure 9 

 
Add the following details:  
 
Entity Type. This can only be either individual or sole trader, all other entity types are not applicable.  
 
Client Code: Client codes can be manual or automatically created. In case of automatic coding, each code may be broken up into 
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several segments. The client code can be based on up to six criteria, i.e. client name, office, partner, department, manager and a 
unique number generated by the system. For further details, refer to the Settings section.  
Name: Enter the name of the client. Clicking the lookup displays an additional screen to add details on the individual such as Gender, 
Title, Forename and Surname, salutations (both formal and informal). 
 
Partner: Select the name of the partner in charge of this client from the drop-down list. Alternatively, click the Partner link to display 
the Select Partner window. Select a partner from the list. 
 
Manager: Select the name of the manager from the drop-down list. Alternatively, click the Manager    link to display the Select 
Manager window. Select a manager from the list. 
 
Lead Staff: Select the lead staff from the drop-down list. Alternatively, click the Lead Staff link to display the Select Staff window. 
Select the lead staff from the list.  
 
Business Type:  Select business type from the drop-down list. Alternatively, click the Business Type lookup to display the Business 
Type window.  
 
Password: Enter the password for the client. System will ask for the Password if you try to edit the client. 
 
Confirm Password: Enter the Password again to confirm and save it in the database. 
 
Tax Year: Select the Tax Year from the drop down list. Initially this will be 2007 or 2008 but each year will be added in annual 
updates 
 
Tax Client: This will automatically be set to on on the add screen but can be taken off on the edit. Tax Clients will be displayed in the 

Client and Tax Returns Browse with this icon beside them . 
 
To save the client details, Click OK. 
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Add A New Tax Year 
For existing clients, you can add a New Tax Year from the Client and Tax Returns browse. Add Tax Return window appears.  

 
Figure 10 

 
It will display the Entity Type, Client Code and Business name. You can enter Password and Confirm Password to restrict access of 
the client. Select Tax Year from the drop down menu. Click ok to save the details. A new Tax year will be generated for the client.  
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ROS Import 
The ROS Import option allows you to find and select a clients ROS .f11 file and import their information into the Relate Personal Tax 
database.  The first thing to do is to setup your default Path For F11 Files. To set this up goto Tools >Settings and then select the Tax 
Details Tab. 
 
Half way down the screen enter the Path for F11 Files. 
 

 
Figure 11 
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Once this has been setup click File > ROS Import from the main menu or click the ROS Import button from the Clients and Tax 
Return browse. 
 
The following screen will appear:  
 

 
Figure 12 

 
The system will list all of the .f11 files that have not been imported into Relate Personal Tax Manager. If you have other 
directories and not one master directory you can click on the “Search for F11 files” button and select the XML folder 
path. The list of all xml files automatically appears in the window with imported flag set to ‘No’.  Select the file you want 
to import.  
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Click ROS Import button. Select Code window appears. 
 

 
Figure 13 

 
This should default to the client if the PPS number agrees. If they do not you will need to select the client which the .f11 file relates to/ 
Select a client code from the drop down menu. The xml file will be imported into this client. Once you select the client code, the PPS 
number and address will be displayed. Once the xml file has been completely imported the imported status will be set to ‘Yes’.  
 
use the ROS Import & Rollover button, to import the XML files and perform a tax year Rollover. This will do exactly the same as the 
ROS Import button but it will also create a new blank tax year for the clients next tax year. It is a timesaver. 
 
Use find tool to search for a client’s form 11.  
 
Use Refresh tool to refresh the list of xml files in the import window based upon the path selected. 
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Rollover 
Click the Rollover button on the clients and tax return browse to create a new tax year. When you click the button on an existing tax 
year the following message will appear.  
 

 
 

Once the procedure ends, a new tax year will be generated. 
 
Note: The status must be set to ‘Submitted’ before a rollover can be run on a clients tax return. To update the status on a return 
simply right click on the return in the browse and click the Status option or click the Status button on the toolbar. 
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Status 

To view the Status on a Client Tax return, Click on the Status tool from Toolbar  . Client and Personal Tax Year Status 
window appears as follows. 

 
Figure 14 

 
The Tax Return Status screen shows the workflow Tasks as listed on the left side of the screen. Tasks can be marked Completed 
only if the previous Tasks are also marked as Completed. See Figure 4. The different status types available are ‘Not Started’, ‘In 
Progress’ or ‘Completed’. The Staff member responsible for the Task and the Completed date may be selected. A Note may also be 
entered. The Staff name will automatically default to the user logged in but this may be changed by clicking on the down arrow. 
Similarly the date will default to today’s date. Only when the Status “Submitted” is set to Completed the system will allow performing 
rollover routine. 
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Backup/Restore 
The backup routine allows the user to backup a single client tax return to a local pc or memory key. This allows you to take details of 
a clients tax return home to work on. The Backup screen will appear as follows: 
 
 

 
 

Click Backup and a message will appear “Backup Completed”. If you go to explorer you will see a series of backup files with the 
extension .ptax. 
 
Restore will perform the reverse routine and update the database with the new information. 
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Check-Out/Check-In 
The check-out routine works in the same as the backup routine but the difference is that the clients tax return is now locked on the 
system so that nobody can change the details until the return is checked back in. The Checkout screen will appear as follows: 
 
 

 
 

Click the Check-Out button a message will appear “Check-Out Completed”. If you go to explorer you will see a series of checked-out 
files with the extension .ptax. 
 
The Checked-Out column on the client and tax return screen will have the word “Yes” filled in. The tax return will also change colour 
from black to red to indicate is has been checked-out. 
 
Check-In will perform the reverse routine and update the database with the new information. 
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Payment 

Select the   button from the toolbar. The payment window opens.  
 
 

 

Figure 15 
It displays each of the tax years entered for this client and holds the following information , Previous Year Liability, Preliminary Tax 
Paid, Current Tax Liability, Balance Due. Enter the amount you have paid as Preliminary Tax, Balance Due will be the difference of 
Current Tax Liability and Preliminary Tax Paid.  
 

Expand All/Collapse All 
As the number of returns on the system hit hundreds of returns it is often helpful to collapse the main client and tax return list. This 
effectively displays just the client list with the clients most current year displayed. Expand will reverse this and show all clients and all 
tax returns. 
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Return Summary Dashboard 
The Return Summary screen is updated as you process information. It will tell you how many returns have not been created yet, how 
many are incomplete. The middle Return Status will quickly show you how many of your current year tax returns are at different 
stages of completion. 
 

 
Figure 16 

Click this bar to show or hide summary details 
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Search 
The Fastsearch feature is activated as soon as you begin to type part of the client name while in the clients and tax return browse. If 
you cannot find the client using the Fastsearch feature click on the magnifying glass button and you can search the full list using all 
fields. 

  
 
There is also a filter option on the search screen which allows you to further reduce your search criteria. 

Begin Typing on browse to use Fastsearch function 
Search for a client using the Find 
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PERSONAL TAX RETURN FORM 11 

The tax return schedules are made up of the following sections: 
 
Personal Details 
Self-Employed Income 
Irish Rental Income 
PAYE/BIK/Pensions 
Foreign Income 
Irish Other Income 
Exempt Income 
Charges & Deductions 
Personal Tax Credits 
Restriction Of reliefs 
Request For Short Notice 
Capital Gains 
Chargeable Assets 
Property Based Incentive 
 
Each section will have a number of subsections, each of which contains information which must be completed depending upon the 
complexity of the clients tax return. 
 
Some of the sub sections have additional drilldowns into the schedules where you can add a breakdown on a particular figure, an 
example of this is Irish Rental Income under Gross Rent Receivable 
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Personal Details 
When you add a new tax year or double click onto an existing tax year the following screen will appear: 
 

 
Figure 17 

 
The layout and content of the above pages are very familiar to users of the Revenue Offline application. These have been developed 
with users of this application in mind. It allows for an easy transition. Simply go through each page by using the Back and Next 
buttons. If you have converted the data over from an .f11 file the information will just need to be edited to complete the return. 
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The following screen shows an example of where sections have been filled in. 
 

 
 
The above screen is highlighting all of the tax return areas that have been filled in for Ray Rogers. The system has a series of alerts 
and messages as well as validation errors where information has not been entered properly or completely. 
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Click on Personal Details and the following screen will open. You will have to provide details on Self and Spouse on the client 
depending upon marriage status.  
 
Complete the information requested. 
 

 
Figure 18 

Name 
Enter the name of the client. For example, Ray Rogers (refer Figure 7). 
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PPS No  
Enter the PPS no of the client. Personal Public Service Number (PPS No.) is unique. This is mandatory information for filling the Tax 
Form.  This is an eight digit unique number in which the first 7 numbers are digits and the last one is an alphabet for self. In Figure 7, 
it is 3432024B. 
 
Agents TAIN 
Tax Consultant’s TAIN number will be automatically displayed in the cell. This is the Tax Adviser Identification Number. This can be 
added through Tools>Settings>Tax Details. 
 
Client Reference Number 
Enter the Client‘s reference number here. This is usually an internal file reference and is not mandatory. 
 
Marital Status 
Enter Marital Status of the Client. This is mandatory field. Marital status may be: single, married, married but living apart, divorced or 
widowed. If you choose ‘Married’, the next few Points will be active.  
 
If ‘Married’, please indicate your basis of assessment 
Select from the drop menu the basis of assessment. The options are: Joint Assessment, separate Assessment, Separate Treatment. 
In Figure 7, ‘Joint Assessment’ is selected. 
 
Note: Continue to complete all the information you deem necessary to complete the Personal Details section for your client. You can 
click the Next button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Self Employed Income 
This section provides details of any income or expenditure from Trades and Employments. From the Tree view, select Self-Employed 
Income. The Self Employed Income section opens. You can add upto a maximum of eight trades under this section. Simply click the 
“Add Trade” button and run through the sub section information to complete the trade. 
  

 
Figure 19 
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The only additional information which can come from outside the database is the “Extracts From Accounts” 
 

 
Figure 20 

 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 

Extracts from Accounts will automatically pull 
accounts figures in from Relate Accounts 
Production 
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When the “Extracts from Accounts” Button is pressed the Relate Personal Tax extracts specific Nominal Reporting Group Values 
directly from the set of accounts in Relate Accounts production. Below is a list of the nominal reporting groups broken down by 
section. The “Adjustments” section on page three refers to the “Disallowed for Tax” total on the groups as opposed to the year end 
figure. 
 

Personal Tax Item RAP Nominal Group 

Income  
Sales/Receipts/Turnover TurnTax - GovGrants 

Receipts from Government Agencies GovGrants 

Other Income including tax exempt income OthIncProf 

  

Trading Account Items  
Purchases CostSalesTax + DirCostsTax 

Gross Trading Profits Total of Groups above 

  

Expenses and Deductions  
Salaries/Wages, Staff Costs EmpeeCost 

Sub-Contractors SubConCost 

Consultancy, Professional Fees LegProf 

Motor, Travel and Subsistence MotExpTax + TravSubsist 

Repairs/Renewals Repairs 

Depreciation/Goodwill capital write-off DepnPrLsAdmin 

Provisions including bad debts – positive BadDebts 

If negative state amount here  

Other Expenses (Total) OthExp + PremCosts + GenAdmin + AdvPromEnt + 

InterestTax + OthFinChg 
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Capital Account Mappings 
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Personal Tax Item RAP Nominal Group 

Capital Account and Balance Sheet Items  

Cash/Capital Introduced CapAccFndsIntr 

Drawings (Net of Tax and Pension contributions) CapAccFndsWd 

Closing Capital Balance – positive CapAccBFwd + RetPrBFwd + RetPr + CapAccFndsIntr + 

CapAccFndsWd 

Stock, Work in progress, Finished goods StkFinGdsRawMatWIP 

Debtors and Prepayments DrsPrepOthCurrAss 

Cash/Bank Debit BankCash 

Bank/Loans/Overdraft Credit LnsOdBankAccs 

Client Account Balances Debit ClientBank 

Client Account Balances Credit ClientBank 

Creditors and Accruals TradeCrAcc + OthLiab – TaxSocSecCr - CorpTaxCr 

Tax Creditors TaxSocSecCr + CorpTaxCr 

Net Assets – positive NetAss 
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Adjusted Profit Computation Mappings 
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Personal Tax Item RAP Nominal Group 

Extracts from Adjusted Profit 

Computation 

 

  

Profit/Loss  
Net Profit per Accounts RetPr 

Net Loss per Accounts RetPr 

  

Adjustments  
Motor Expenses MotExpTax 

Donations (Political and 

Charitable)/Entertainment 

CharPolit 

Light, Heat and Phone LightHeatTax + TeleFaxTax 

Net gain on sale of fixed/chargeable assets PrLsDispAdmin 

Net loss on sale of fixed/chargeable assets PrLsDispAdmin 
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Irish Rental Income 
The main rental income screen appears as soon as you click Claim To Tax Relief sub section from the main Irish Rental Income 
section. Complete the schedule as laid out.  
 

 

Figure 21 
 
If the client has more than one property click on the “Gross Rent Received” hyperlink. A Schedule for Irish Rental Income Window will 
appear. Complete the details of each Property here. Enter Property details, to whom applicable (self/spouse), income, Interest, 
Interest, Repairs, Others, Section 23, Exempt, Net Profit, Capital Allowance Balance figures  
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Figure 22 
Information can be added like in a spreadsheet. Simply right click to the field you want type in the detail and press enter to save. Click 
on the Save & Close button to exit the schedule and go back to the sub section. 

 

Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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PAYE/BIK/Pensions 
This section is one of the largest sections of the database. The sections to complete are as follows:  
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There are only two sections that vary to the other sections, Deferred Payment (Seven year deferral under Section 128A TCA 1997) 
and Election under Section 128A(4A) TCA 1997 [SO3 Election]. 
 

 
 
 
Simply click the “Add” button and the system will display the details to enter to complete a deferred payment, click Next and the 
browse will be updated. 
 
 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Foreign Income 
Foreign dividends are quite popular and we have ensured that you can add a detailed schedule drilldown of dividends under the 
following headings: 
 
Schedules 
Great Britain and Northern Ireland Dividends 
US Dividends 
Canadian Dividends 
 
Grids  
Foreign Life Policies 
Offshore Funds 
Other Offshore Products 
Foreign Bank Accounts 
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Foreign Income – Great Britain and Northern Ireland Dividends 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Figure 23 
 
The above schedule has a hyperlink so that you can add a schedule of dividends. Click into the “Net Amount Received” and the 
following screen will appear: 
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Enter Property Details, for Self/Spouse, along with the date, Nominal Value and Dividend amount received. The Sum of 
Dividend for Self as well as Spouse, appears in the Self and Spouse cell of Figure 24. 

 

Figure 25 
 
US and Canadian Dividend Schedules are done in the same way as the GB/NI Dividends but the schedule has more information to 
enter. 
 
 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Irish Other Income 
This section is straight forward with only two drilldown schedule which are similar to the Dividend schedules and are held under the 
sub heading Irish Deposit Interest.   
 
Click the “Gross Amount of Dividends from Irish Resident companies (from which Dividend Withholding Tax was deducted” and the 
following screen will appear: 

 

 
 
 

 
 
 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Exempt Income 
This section is straight forward with only one screen as follows: 

 

 
 

 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Charges & Deductions 
This section contains RACS which are not the run of the mill postings that we have shown to date in the manual. There are a number 
of hyperlinks which need to be updated in order to complete the creation of an RAC. 

 

 
 

 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Personal Tax Credits 
This section defines the allowances, reliefs and credits that are applicable to your client. The number of subsections are as follows: 
 

 
 
 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Restriction of Reliefs 
This section is meant for higher income Individuals. To enter amounts in different accounts click on the following links. To remove 
entries from the links click Delete RR1 form button. 

 

 
 
Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 
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Request for short notice 
This section contains only a single tick box where you request a Short Notice of Tax Assessment. This is a shorter form and does not 
give a breakdown of allowances etc.  
 
 
 

Capital Gains 
This section outlines any Asset Disposals that your client has undertaken from Shares, Land & Property to Foreign Life Policies. 
 

 

 

Note: Continue to complete all the information you deem necessary to complete this section for your client. You can click the Next 
button to go onto the next sub section. If you click Home it will bring you back to the start of the section you are on. 



Success Built on Service   61 

Chargeable Assets 
This section covers any assets acquired during the tax period. Simply fill in the information, there is only a single input screen to 
cover this area. 
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Property Based Incentive 
This section covers investments in property with specialist interests such as Park & Ride, Seaside Resort and Urban Renewal. It 
covers a considerable list of such investments for both Self and Spouse. 
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CALCULATION & SUBMISSION 

Once you have completed inputting the tax return information and you are happy that you have completed each of the sections and 
subsections, simply click on the Calculate button on the tax return screen. 
 

 
 
When you click the calculate button Relate Personal Tax Manager will automatically go onto the internet and go to the Revenues Tax 
Calculation Engine and return a Form 11 Calculation Report. The report is based upon figures returned from Revenue. 
 
The figures are not live and are not submitted anywhere, they are simply returned to the package so that the user can see what the 
clients tax liability and return will be like. 

Calculate using ROS Web Services 
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Calculation Report 
The calculation report created looks like the following:  
 

 
 
As per the screen above the layout has been formulated to be in line with the Revenue Offline Application but has been improved to 
ensure that the layout stays on as few pages as necessary and that the fonts have been consistently applied. 
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Validation Error Report 
The validation error report is created when something ahs been entered which cannot be returned to the ROS calculation engine. 
Self validations help to ensure that returns adhere to the Revenues systems. The validation error report will appear as follows:  
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Form 11 
Once you are happy with the Form 11 calculation report you can decide to print the full Form 11 form by clicking on the Form 11 
button on the tax return screen. 
 

 
 

Form 11 Return 
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The Form 11 Form will look like the following screen and will run to a few pages outlining every section that has been completed as 
well as sections that are not applicable.  
 

 
 
The last page has the signing section and declaration which your client needs to sign. There is an option to create an export file to 
PDF for sending to your client for signing. 

Create PDF Form11 for 
emailing to your client 
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Submission  
Once you are happy that the client has accepted the tax return and the tax liability, it is time to submit the return. Click the Submit 
button on the tax return screen. 
 

 
 
The current version of Relate Personal Tax Manager will bring up the following message: 

Submit 
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The message explains that the software has generated a Form 11 xml file in the default ROS F11 directory. When you click OK the 
system will automatically launch the ROS login screen as follows: 
 
 

 
 
 
Login as you normally would and upload the return. Relate are working on a direct submission routine from the package itself which 
will cut this cumbersome part of the process out. This upgrade will be made available to all users as part of their normal licence 
agreement. 
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DATA MINING 

Data mining is a tool used to interrogate the tax database of client information to help manage the tax return process. It is also used 
to target, sell and market the firms tax services. The data mining routine will give the user the ability to do complicated search and 
retrieve operations on the client database i.e. create a list of all clients who have income in excess of €100,000 who did not do BES 
or use Film last year. 
 
The user can create as many data queries as they like. To create a datamine click on Data Mining on the navigation bar.  
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Then click New. The Query window appears showing the Details tab.  
 

 
 
In the Details tab page, you have to specify the kind of query that you want to generate.  
 
Enter the following information:  
Description of Query  
Query Group - Select the group of the query from the drop-down list. If the group you are looking for is not a part of the list, then you 
can enter the name of the query group here. It will be added to the list, for you to use the next time.  
Source of Information  
 



Success Built on Service   72 

 
Click on the Query Builder Tab. The Query Builder window appears showing the following:  
 

 
 
The Query Builder helps you define the information you are looking to retrieve from the database. The query statement appears at 
the bottom of the screen. 
 
Select the section or field name that you are looking for, from the Field drop-down list. Then select the condition that you want to 
specify from the Condition drop-down list. Once that has been done, enter the value that you are looking for in the Value box. Select 
either “and” or “or” depending on whether you want all the conditions that you have specified, to be met or any one.  
 
Multiple lines can be entered here for detailed queries. 
 
 
 



Success Built on Service   73 

 
Click on the Fields Tab to select or unselect the fields of information you want to appear on your datamine. These fields will be 
available for mailmerge once the query is “run”. 
 

 
 
 
Once you are happy with the created query Click Save & Close to retain your data mining results.  
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Back on the datamining screen click the Run Query button as in the screen below. 
 

 
 

Run 
Query 
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The Query screen will appear as follows: it lists  up all the records in the database that fulfill the criteria set in the query builder. The 
user can now click on the Microsoft Word button and do a standard letter mail merge requesting or offering information to the clients 
listed. The user can click on the Microsoft Excel button and export the list into a perfectly formatted Excel Spreadsheet for further 
analysis. 
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If you are on a network you may want to keep all of your particular saved queries in a directory so that they are available to all staff 
members. If you click the Settings button on the Data Mining screen you can agree a network path. 
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REPORTS 

There are two main reports which can be run from the text Reports menu: 
 
Client Listing Report 
Exception Report 
 
Client Listing Report 
The Client Listing Report selection criteria is as per the screen below. Make the relevant selections you require such as give me a list 
of all clients with a status of “Draft Returns Generated”. 

 
 
 
The report will then list all clients with this status along with their other information. 
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Figure 26 
Exception Report 
The Client Exception Report Compares each Client record according to the Tax year chosen with each field value entered into the 
Tax form of the previous year and generates a report of unmatched fields for the Clients chosen. If you have entered something into 
2007 but have not entered something into the same section for 2008 it will throw up an exception. 
 
  

 
Figure 27 

 
This is very important and helps to identify potential missing information. Generally speaking if a client had something last year, they 
should have it again this year. 
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STAFF  

If you are a firm who already use ether DRIVE or Relate Accounts Production your staff file will automatically appear in Relate 
Personal Tax Manager, as it is the same database which is being used by all three applications. 
 
If you are not an existing user go to the Staff option on the navigation bar and click on New, the following screen will appear: 
 
 

 
 
Fill in the relevant information and click OK to save the new staff member. 
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TOOLS 

Settings 
From the Tools menu, choose Settings. The Settings window appears. Select Practice Details tab.  
 

 
Figure 28 

Enter the name of the practice. Enter the contact address along with the contact phone numbers, mobile and fax numbers, e-mail and 
web address. This information is used as the contact information for the Revenue when queries arise and also for email responses. 
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Select the Client Codes tab.  

 
Figure 29 

 
Select the Use Automatic Code Generation check box, if you want the client codes to be automatically generated by the system, 
when entering Client Details. Each code may be broken up into several segments.  
 
The client code can be based on six criteria: client name, office, partner, department, manager and a unique number. This unique 
number may be system unique or it may be code unique. 
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Select Tax Details Tab. 

 
Figure 30 

The following information is critical for the proper setup of your tax package: 
 
Enter the TAIN Number of the Practice. This is your official TAIN as issued by ROS. 
Enter the ROS Web Server URL here. (The complete Form 11 will be posted here automatically at a later release.) 
View Last Year Details – (This will show last year’s figures alongside the current year for comparison on the schedules) 
UK Conversion Rate & US Conversion Rate 
Path for Saved F11 Files.  
Use Web Services for F11 Files (This will automatically submit F11’s without needing ROS upload, only available in a later release ) 
Use Offices, Departments  
Hide Closed Clients 
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Change Database 
The Change Database feature allows the user to work with multiple databases and change the database from within the application. 
This is very rarely used and is not a free option.  
 
Changing the Database 
From the Tools menu, choose Change Database option. The Change Database window appears. 
 

 
Figure 31 

 
Enter the following details: 
Select Server - Enter the server name in which the database you want to change to resides. 
Select Database - Select the database you want to change to. 
Click ok to save. 
 


